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About the Document

This User Guide covers all the information about how to install and use Segrite Endpoint
Protection in the easiest possible ways. We have ensured that all the details provided in this
guide are updated to the latest enhancements of the software.

The following list describes the conventions that we have followed to prepare this document.

Convention Meaning

Bold Font Anything highlighted in bold indicates that it is a direction about how
to carry out an action.

This symbol indicates additional information or important
information about the topic being discussed.

<Step 1> The instruction mentioned in the numbered list indicates actions that

<Step 2> you need to perform.
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Seqrite Endpoint Protection Highlights

Seqrite Endpoint Protection ensures maximum protection against any possible threats or
malware that may infect your system when you browse online, work in network environment,
and access emails. You can schedule scanning, set rules for Quarantine and Backup for files,
and block malicious emails and spams.

Mac Security Helps you customize the settings that concern the protection of files and
folders in your system. You can set scanning preferences, apply rules for virus protection,
schedule scanning, exclude files and folders from scanning, and set rules for quarantine and
backup files.

Web Security Helps you set the protection rules to save your machine from malicious files
that can sneak into your system during online activities such as banking, shopping, surfing and
so on.

Email Security Helps you customize the protection rules for receiving emails from various
sources. You can set rules for blocking emails which are suspicious of spam, or malware.

For more information, please visit http://www.seqgrite.com.
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chapter2. Getting Started

Seqrite Endpoint Protection is simple to install and easy to use. During installation, read each
installation screen carefully and follow the instructions.

Prerequisites

Remember the following guidelines before installing Seqrite Endpoint Protection on your Mac
machine:

e Asystem with multiple anti-virus software programs installed may result in system
malfunction. If any other anti-virus software program is installed on your system, you need
to remove it before proceeding with the installation of Seqrite Endpoint Protection .

e Close all open programs before proceeding with installation.

e Werecommend you to keep a backup of your data in case your system is infected with
viruses.

e Segrite Endpoint Protection must be installed with administrative rights.

System Requirements

To use Seqrite Endpoint Protection , your system should meet the following minimum
requirements:

e MacOSX10.12,10.13, 10.14, 10.15, 11, 12, 13 and 14

e Mac devices with Intel Processor or Apple M1, M2, M3 chip
e Minimum 512 MB of RAM, 2 GB or more is recommended
e 1200 MB free hard disk space

The requirements provided are minimum system requirements. We recommend that your system
should have higher configuration to obtain best results.

To check for the latest system requirements, visit: http://www.seqgrite.com.

Clients that support email scan

The POP3 email clients that support the email scanning feature are as follows:
e Apple Mail Ver. 10.3 and later

e Thunder bird

e Sparrow

e Sea Monkey

e MailSmith
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Clients that do not support email scan

The POP3 email clients and network protocols that do not support the email scanning feature
are as follows:

o IMAP

e AOL

e POP3s with Secure Sockets Layer (SSL)

e Web based email such as Hotmail and Yahoo! Mail

e Lotus Notes

SSL connections not supported

Email Protection does not support encrypted email connections that use Secure Sockets Layer
(SSL). If SSL connections are being used, the emails are not protected by Email Protection.

Installing Seqrite Endpoint Protection on Mac System

Before you install Mac client, create Mac Client installer on the Endpoint Server in the following
way.

To create a Mac Seqrite Client installer, follow these steps:
1 Logon to the Seqrite Endpoint Protection .
2 Goto Deployment.
3 Click the Create Installer button to create the Client Installer.
The Create Client Installer dialog opens.
4 Enter Installer Name and select Group.
In the OS platform list, select Mac.

6 Adefault Validity period of 30 days is selected. You can change it to 60 or go days if
required.

7 Adefault folder path to install is displayed. Make note of it.
8 Click Create. The <Installer Name>.TAR file is created.

The installer without antivirus setup is created and appears in the list on Deployment > Client
Installer page. You can download this installer.

Note

With Standalone Installer, you can create Mac client installer with antivirus setup.

Email Install Link

Email Install link allows you to send an email notification to the endpoints in the network to install the
Seqrite Endpoint Protection client.

To notify clients to install the Seqrite Mac client, follow these steps:

Getting Started 9



1 Logon to the Seqrite Endpoint Protection.

2 Select Deployment > Email Install link.

The Email Install link screen appears.

3 Inthe Tofield, type the email address.

In case of multiple recipients insert a semi colon (;) between email addresses.
You may modify the subject line of the message if required.

4 Click Send Email.

A Notify Install message containing a link for the installer file is sent from the administrator before
installing Seqrite Endpoint Protection .

5 Toinstall EPP Client on a Mac system, type the installer link in the browser.
The link is sent to you to your email address.

A web page appears that displays the prerequisites for the installation and includes a link to the installer
file (Download Mac Client). Read the prerequisites carefully.

6 Click the Download Mac Client link.

Atar file is downloaded that includes the installer.

7 Goto the location where you have saved the tar file and extract all its components.
8 Double-click the installer file (MCLAGNT.DMG).

9 Runthe Installer to start the Segrite Endpoint Protection installation.

Note:

e Device Control, Data Loss Prevention depend upon Virus Protection.

e Phishing Protection, Browsing Protection, and Web Security may create multiple
reports for a single instance if restricted URL is run on Opera browser.

e Notification for Remote Scan, Remote Update, and Remote Un-install from EPP web
console cannot be sent if Mac client user is not logged on to the Mac machine.

Installing Seqrite Endpoint Protection Mac client on
macOS Catalina and above

macOS Catalina and above versions requires approval from the users to run the Installer for
Endpoint Protection for Mac, when tar file is extracted on Desktop/Downloads folder.

1 While installing EPP Mac client, a prompt appears to ask permission to access
Desktop/Downloads/Documents folder where MCCLAGNT.TAR/MCCLAGAV.TAR file is
extracted.

2 To continue installation, click OK.
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= For Users having macOS Catalina, the following system extension prompts will appear
one by one when the installation starts. Click Open Security Preferences on all the

prompts.

System Extension Blocked

. & The program “opsapp” tried to load new system
extension(s). If you want to enable these extensions,

open Security & Privacy System Preferences.

Self-protection (ggcext) prompt

System Extension Blocked

< 4 The program “opsapp” tried to load new system
extension(s). If you want to enable these extensions,

open Security & Privacy System Preferences.

Online protection (Opsext) prompt

System Extension Blocked

. & The program “opsapp tried to load new system
extension(s). f you want to enable these extensions,

open Security & Privacy System Preferences.

Data Loss Prevention (dlpext) prompt

System Extension Blocked

. 4 The program “opsapp” tried to load new system
extension(s). If you want to enable these extensions,

open Security & Privacy System Preferences.

File Activity Monitor (famext) prompt

System Extension Blocked

4 ¢ The program "webflt" tried to load new system
extension(s). If you want to enable these extensions,

open Security & Privacy System Preferences.

Web Security (webflt) prompt

Getting Started 11



System Extension Blocked

5 & The program “mailflt" tried to load new system
extension(s). If you want to enable these extensions,

open Security & Privacy System Preferences.

Email Security (mailfit) prompt

= For Users having macOS Big Sur and above, the following prompts will appears one by
one when the installations starts. Click Open Security Preferences on all the prompts.

)

System Extension Blocked

The program "opsapp” tried to load new
system extension(s). If you want to
enable these extensions, open Security
& Privacy System Preferences.

OK

Open Security Preferences

Self-protection (ggcext) prompt

)

System Extension Blocked

The program "opsapp” tried to load new
system extension(s). If you want to
enable these extensions, open Security
& Privacy System Preferences.

OK

Open Security Preferences

Data Loss Prevention(dlpext) prompt

Getting Started

)

System Extension Blocked

The program "opsapp” tried to load new
system extension(s). If you want to
enable these extensions, open Security
& Privacy System Preferences.

OK

Open Security Preferences

Online protection (Opsext) prompt

©

System Extension Blocked

The program "opsapp” tried to load new
system extension(s). If you want to
enable these extensions, open Security
& Privacy System Preferences.

OK

Open Security Preferences

File Activity Monitor (famext) prompt
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System Extension Blocked System Extension Blocked
The program "webflt* tried to load new The program "mailfit* tried to load new
system extension(s). If you want to system extension(s). If you want to
enable these extensions, open Security enable these extensions, open Security
& Privacy System Preferences. & Privacy System Preferences.
Open Security Preferences ‘ Open Security Preferences
Web Security (webflt) prompt Email Security (mailflt) prompt

3 Userneedsto ALLOW all the above shown system extension prompts to ensure the
following settings on macOS Catalina and above.

Go to System Preferences > Security & Privacy.
Click the lock icon and provide the password if it is locked.

Click the Allow button as shown in the following screenshot.

r Bl
o < i Security & Privacy Q
General = FileVault = Firewall  Privacy
A login password has been set for this user Change Password...
Require password 5 minutes after sleep or screen saver begins
Show a message when the screen is locked
Disable automatic login
Allow apps downloaded from:
App Store
© App Store and identified developers
System software from application “opsapp” was blocked Allow
from loading.
2}
[l Click the lock to prevent further changes. Advanced... ?

Getting Started
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Security & Privacy

General FileVault Firewall Privacy

e e e

System software from the following developers was updated and the
) system needs to be restarted before it can be used.
| opsapp
webfit
mailfit
Al
Cancel -:: .
Some system software requires your attention before it can be used. Details
~
1] lick the lock t evant further ct " Advanced. ?

Note: On macOS Catalina “Placeholder Developer” is shown instead of the corresponding app name.
Issue is acknowledged by Apple and according to Apple, will be solved in Big Sur.
https.//developer.apple.com/forums/thread/130056

iv.  The list of updated system software appears. Click Ok.

V. Restart your computer.

Permission required to support macOS Catalina and above

Product’s [Seqrite] & Services would require permission to access system files on macOS
Catalina and above. After Allowing all Apps and Services, system restart is required.

1 Post successful installation of Seqrite Endpoint Protection, the following prompts appear.

= For Users having macOS Catalina, the following prompts will appear. Click Allow on all
the prompts.

“mailflt” Would Like to Add VPN
Configurations

All network activity on this Mac may be filtered or
monitored when using VPN.

Email Security VPN configurations
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"webflt” Would Like to Filter
MNetwork Content

All network activity on this Mac may be filterad
or monitored.

Web Security Network content

For Users having macOS Big Sur and above, the following prompts will appear. Click
Allow on all the prompts.

“mailfit” Would Like to Add Proxy “webfit” Would Like to Filter
Configurations Network Content

All network activity on this Mac may be

All network activity on this Mac may be
filtered or monitored.

filtered or monitored.

Allow Don't Allow Allow Don't Allow

Email Security VPN configurations Web Security Network content

2 Avprompt prompt message will appear as shown below.

Segqrite Endpoint Protection
Your current macOS privacy settings do not allow Segrite for Mac to
protect your system completely.

Allow Full Disk Access to the following processes in the System
Preferences > Security & Privacy > Privacy tab,

/Library/Application Support/Seqrite/Seqrite/opssvc
/Library/Application Support/Seqrite/Segrite/qhhlpdmn
/Library/Application Support/Seqrite/Seqrite/dIpscanner
ILibrary/Application Support/Seqrite/Seqrite/scanner.app {
/Library/Application Support/Seqrite/Seqrite/update.app

/Library/Application Support/Seqrite/Seqrite/schddmn
/Library/Application Support/Seqrite/Seqrite/dcsvc

Click "Open Preferences” to launch System Preferences.

Cancel Open Preferences t
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AVprompt

3 Do the following settings on macOS.
i.  Open System Preferences.
ii.  Goto Security & Privacy > Privacy tab.
iii.  Clickthe lock icon and provide the password if it is locked.
iv.  Select Full Disk Access in the left pane.

4 Add the following processes in the given path and then select the processes in the Security
& Privacy Full Disk Access window,

= /Library/Application Support/Seqrite/ Seqrite/opssvc

= /Library/Application Support/Seqrite/ Seqrite/ghhlpdmn

= /Library/Application Support/Seqrite/ Seqrite/dIpscanner
= /Library/Application Support/Seqrite/ Seqrite/scanner.app
= /Library/Application Support/Seqrite/ Seqrite/update.app
= /Library/Application Support/Seqrite/ Client Agent 10.11/Endpoint Protection Client
= /Library/Application Support/Seqrite/Segrite/schddmn

= opsext (already present in the privacy section)

= ggcext (already present in the privacy section)

=  Dlpext (already present in the privacy section)

= famext (already present in the privacy section)

= /Library/Application Support/Seqrite/Seqrite/dcsvc (applicable only to macOS Big Sur
and above)

5 The above processes may be added automatically. In this case, only select the processes in
the Security & Privacy > Full Disk Access window.

@ < #H - Security & Privacy Q
General | FileVault  Firewal il Privacy
-
P Allow the apps below to access data like Mail,
17 Calendars Messages, Safari, Home, Time Machine backups and
certain administrative settings for all on th
Reminders Mac.
& Photos
AR scanner
M4 Comera
dipext

B Clickt k to pre t further change Advanced. 2

The following screenshot will appear showing Full Disk Access configuration in System
Preferences.
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[ ] < i Security & Privacy Q

General FileVault Firewall Privacy

-
_— Allow the apps below to access data like Mail,
17 Calendars Messages, Safari, Home, Time Machine backups and
certain administrative settings for all users on this

Reminders Mac.

& Photos [l creroint security Client
4§ Camera
- dlpscanner

Microphone
W Micre B oo
ﬂ Speech Recognition

- ghhlpdmn
Accessibility

“i2 Input Monitoring

+ —

Full Disk Access

Bl Click the lock to prevent further changes. Advanced... ?

Full Disk Access

If you install Seqrite Endpoint Protection Mac client on macOS Catalina for the first time,
the following alert prompt appears,

L)

System Extension Blocked

A program tried to load new system
extension(s) signed by "Quick Heal
Technologies (P) Ltd." If you want to
enable these extensions, open Security
& Privacy System Preferences.

Open Security Preferences

Note: The above prompt does not appear on macOS Big Sur and above (Intel and Apple’s ARM64)
system.

6 To function Seqrite EPP Mac client on macOS Catalina and later, do the following.
i.  Click Open Security Preferences.

i.  Allow "Quick Heal Technologies (P) Ltd.” from the ‘System Preferences >> Security &
Privacy’.

7 The following screenshot displays mailflt & webflt network extensions connected state in
System preferences > Network

Getting Started 17



[ X} < i Network Q

Location: Automatic

Wi-Fi
= .ICthcmmd Status: Connected

. ) Connect Time: 01:10:19 Sent:
Mail Protection IP Address: Received:
Connected

com.quic...tworkapp
@ Running

* Bluetooth PAN Server Address: 127.0.0.1

Mot Connected
® Account Name:

Disconnect

VPN Application: mailflt

Show VPN status in menu bar 7
+ | — |@v
r l
[ [} < iii  Network Q,
Location:  Automatic
— Wi-Fi
* @ Connected Please use "webflt" to control this content filter configuration.

Mail Protection
@ Connected

n com.quic...tworkapp
Running

* Bluetooth PAN
@ Not Connected

+[=Je~

Note: Once all the System extensions are allowed and the required permissions are given, then
restart your computer.

Please note:

e Device Control, Data Loss Prevention, and File Activity Monitor depend upon Virus
Protection.
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e Phishing Protection, Browsing Protection, and Web Security may create multiple reports
for a single instance if restricted URL is run on Opera browser.

e Notification for Remote Scan, Remote Update, and Remote Un-install from EPP web
console cannot be sent if Mac client user is not logged on to the Mac machine.

Installing Seqrite Endpoint Protection on Mac System
Remotely

You can install Seqrite Mac Client in one of the following ways.

e Installing using Apple Remote Desktop or Casper

e Connecting remotely using Secure Shell

o Using Terminal (for Mac and Linux OS)

o Using PUTTY (for Windows OS)

Creating Mac client Installer

To create Mac client installer, follow these steps:

1 Onthe Seqrite Endpoint Protection.

2 Goto Deployment, click Create Installer button.

The Create Client Installer dialog opens.

3 Enter Package Name and select Group.

4 Inthe OS platform list, select Mac.

5 Select validity period in the list box. The validity period can be of 30, 60 or 9o days.
6 Click Create.

The <Package Name>.TAR file is created.

The installer without antivirus setup is created and appears in the list on Deployment > Client
Installer page. You can download this installer.

Note

With Standalone Installer, you can create Mac client installer with antivirus setup.

Installing using Apple Remote Desktop or Casper

Apple Remote Desktop (ARD) helps you to connect to the Mac client computers remotely in the
network, send software to them, install software on them, help other end users in real time,
and perform various tasks.

Prerequisites

Before you install Seqrite Mac Client, ensure the following requirements.
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e The administrator computer with ARD or Casper installed must have Mac OS 10.12 and
later.

e Mac Segrite Client installer must be created on Seqrite Endpoint Protection . To know
about how to create client installer, see Creating Mac Client Installer.

e Administrator must have an account on the Mac client computers with admin privileges.
e Enable Remote Management on the Mac client computers.

e Your administrator computer must have Packages installed on it. Packages is a Mac OS
application that helps you to create bundle for your payload and installation. To download
Packages, visit http://s.sudre.free.fr/Software/Packages/about.html.

e For macOS Catalina and above only, do the following on your Mac system,
1 Open System Preferences.

2 Goto Security & Privacy > Privacy tab.

Click the lock icon and provide password if it is locked.

Select Full Disk Access in the left pane.

v W

Add the following process in the given path and then select the processes in the Security &
Privacy Full Disk Access window,

[Library/PrivilegedHelperTools/fr.whitebox.packages/packages_dispatcher

Installing Mac Client using Apple Remote Desktop or Casper

This procedure helps you install Mac client on the remote Mac client computers using ARD or
Casper. For more details, you may refer the documentation of the respective software
applications.

Creating Mac client package

1 On the Seqrite Endpoint Protection, download UEMREMOTEINST.TAR from the URL,
http://dlupdate.quickheal.com/builds/segrite/uemcp/en/UEMREMOTEINST.tar

2 Download Mac client builds (with/without AV) from the EPP server. These builds will be in
TAR format.

3 Rename the Mac client installer as follows:
e Macclient installer (without AV) - MCCLAGNT.TAR
e Macclient installer (with AV) - MCCLAGAV.TAR
4 Extract UEMREMOTEINST.TAR.
Copy MCCLAGNT.TAR or MCCLAGAV.TAR to “<Download directory>/UEMREMOTEINST".

6 Open Terminal.app on the administrator Mac computer and go to the UEMREMOTEINST
folder.

7  Enter the following commands

cd ./Remote Installation/PKG
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sudo sh ./ClientAgentInstaller/CreatePackage.sh

Administrator rights are required for executing this command.

When the package creation completes successfully, ClientAgentinstaller.pkg file is created in
the ./Remote_Installation/PKG/ClientAgentinstaller/ folder.

If the Client Packager is failed to create on macOS Catalina and above, do the following
1 Open System Preferences.

2 Goto Security & Privacy > Privacy tab.

Click the lock icon and provide password if it is locked.

Select Full Disk Access in the left pane.

Select the packages_dispatcher check box.

[« ) LY 2 I ~ B V V]

Now again try to create Client Packager, it will be created successfully.

Deploying Seqrite Mac Client using Apple Remote Desktop
In addition to the Prerequisites described in the preceding section, follow this prerequisite.

Prerequisite

Before deploying Seqrite Mac client, ensure that you get Apple Remote Desktop (ARD) tool
installed on your administrator computer. To download ARD, visit
https://www.apple.com/in/remotedesktop.

To deploy Seqrite Mac client using Apple Remote Desktop, follow these steps:
1 Open Apple Remote Desktop.

2 Select the Mac client computers from the list of all available computers and then click
Install to add the package.

3 Click the plus (+) sign to locate and add ClientAgentInstaller.pkg and then click Install to
begin deployment.

Deploying Seqrite Mac Client using Casper

In addition to the Prerequisites described in the preceding section, follow this prerequisite.

Prerequisite

Before deploying Seqrite Mac client, ensure that you get Casper tool installed on your
administrator computer. Casper helps to install software and run scripts remotely on the client
computers. To download Casper, visit http://www.jamfsoftware.com/products/casper-suite/.

To deploy Seqrite Mac client using Casper, follow these steps:
1 Logonto Casper Admin.
2 Drag ClientAgentinstaller.pkg to the window and then select File > Save.

3 Logonto Casper Remote.
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4 Inthe Computers tab, select the Mac client computers from the list of available computers.
5 Inthe Packages tab, select ClientAgentinstaller.pkg.
6 Click Go.

Connecting remotely using Secure Shell

Secure Shell (SSH) is a network protocol that is used to connect to the remote Mac client
computers over secure data communication through command line to manage client
computers.

Using Terminal (for Mac or Linux OS)

The administrator computer having either Mac or Linux OS can install client using this method.

Prerequisites
Before you install Seqrite Mac client, ensure the following requirements.
e Administrator must have an account on the Mac client computers with admin privileges.

e Enable Remote Login and either allow access for all users, or only for specific users, such as
Administrators. You can find this setting on the Mac computer under System Preferences >
Sharing > Remote Login.

e Ensure that the firewall does not block the port that Secure Shell (SSH) uses, which is by
default TCP port 22. This port allows the required communication for remote login.

e If you use the Mac firewall, disable stealth mode. With stealth mode enabled, the remote
push installation cannot discover the client through Search Network.

e Todisable stealth mode on the Mac computers, do the following,
1 In System Preferences, go to Security and Privacy.

2 Click the Lock icon and provide password if it is locked.

Select Firewall > Firewall Options.

Clear the Enable stealth mode check box if it is selected.

Click OK.

v W

Mac Seqrite client installer must be created on the EPP server. To know about how to
create client installer, see Creating Mac Client Installer.

Installing Seqrite Mac Client

To install Seqrite Mac client using Terminal, follow these steps on the administrator Mac
computer:

On the Seqrite Endpoint Protection, download UEMREMOTEINST.TAR from the URL,
http://dlupdate.quickheal.com/builds/segrite/uemcp/en/UEMREMOTEINST .tar

1 Download Mac client builds (with/without AV) from the EPP server. These builds will be in
TAR format.
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2 Rename the Mac client installer as follows:

Mac client installer (without AV) - MCCLAGNT.TAR
Mac client installer (with AV) - MCCLAGAV.TAR

3 Extract UEMREMOTEINST.TAR.

4 Copy MCCLAGNT.TAR or MCCLAGAV.TAR to “< Download
directory>/UEMREMOTEINST”. Download directory is the directory where you have
downloaded and extracted UEMREMOTEINST.TAR.

5 Open Terminal.app and go to the Remote Installation folder.
6 Enterthe following command

sh ./Scripts/copy.sh <username> <ip address>

Parameter description

sh ./Scripts/copy.sh is static.

<username> specifies the user name of the remote Mac computer such as ‘test’.
<ip_address> specifies the IP address of the remote Mac computer such as '10.10.0.0'.

Example: sh ./Scripts/copy.sh “test” “10.10.0.0"

Enter the password of the remote computer to connect to it.
Enter the command sudo sh /tmp/install.sh.
9 Enter the password of the remote computer when prompted.

10 A confirmation message appears - "If earlier version of Seqrite Endpoint Protection client is
found on the system, then it will be uninstalled automatically. Do you want to continue??
[Yes/No]:".

11 Enter Yes or No.
e Ifyou enter Yes, installation will proceed.

e Ifyou enter No, installation will be aborted with message "Option No has been selected.
Installation aborted."

12 Enter the command exit to close remote SSH session.

13 Repeat steps 6 through 10 to install Seqrite Mac client on a different remote computer.
Using PUTTY (for Windows OS)
The administrator computer having Windows OS can install Client Agent using this method.

Prerequisites

Before you install Seqrite Mac client, ensure the following requirements.
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Administrator must have an account on the Mac client computers with admin privileges.

Enable Remote Login and either allow access for all users, or only for specific users, such as
Administrators. You can find this setting on the Mac client computer under System
Preferences > Sharing > Remote Login.

Ensure that the firewall does not block the port that Secure Shell (SSH) uses, which is by
default TCP port 22. This port allows the required communication for remote login.

If you use the Mac firewall, disable stealth mode. With stealth mode enabled, the remote
push installation cannot discover the client through Search Network.

To disable stealth mode on the Mac computers, do the following,
In System Preferences, go to Security and Privacy.

Click the Lock icon and provide password if it is locked.

Select Firewall > Firewall Options.

Clear the Enable stealth mode check box if it is selected.

Click OK.

Mac Segqrite client installer must be created on the Segrite Endpoint Protection. To know
about how to create client installer, see Creating Mac Client Installer.

If you are using macOS Catalina (10.15) and installing Endpoint Protection for Mac, do the
following,

To proceed with installation, macOS Catalina requires your approval to access directory
where MCCLAGNT.TAR/MCCLAGAV.TAR file is extracted (Example: Desktop or
Downloads or Documents folder). In the System Preferences > Security & Privacy >
Privacy > Files and Folders window, select all the options under accainst to access the
directory.

Installing Seqrite Mac Client

To install Seqrite Mac client using PUTTY, follow these steps:

On the Seqrite Endpoint Protection, download UEMREMOTEINST.TAR from the URL,
http://dlupdate.quickheal.com/builds/seqrite/uemcp/en/UEMREMOTEINST .tar

1

Download Mac client builds (with/without AV) from the EPP server. These builds will be in
TAR format.

Rename the Mac client installer as follows:
Mac client installer (without AV) - MCCLAGNT.TAR
Mac client installer (with AV) - MCCLAGAV.TAR
Extract UEMREMOTEINST.TAR.

Copy MCCLAGNT.TAR or MCCLAGAV.TAR to “<Download directory>/UEMREMOTEINST".
Download directory is the directory where you have downloaded and extracted
UEMREMOTEINST.TAR.

Open cmd.exe and go to the folder "< Download directory>/UEMREMOTEINST".
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Note

6 Do one of the following:
e Enter the following command if antivirus is included in the client packager

\Remote_Installation\Softwares\pscp.exe .\ MCCLAGAV.TAR .\Remote_Installation\Scripts\install.sh
<username>@-<ip_address>:ftmp/

e Enter the following command if antivirus is not included in the client packager

\Remote_Installation\Softwares\pscp.exe \MCCLAGNT.TAR .\Remote_Installation\Scripts\install.sh
<username>@-<ip_address>:ftmp/

Note

When MCCLAGAV.TAR as well as MCCLAGNT.TAR files are present, priority is given to the
MCCLAGAV.TAR for installing the Seqrite mac client.

Parameter description
<username> specifies the user name of the remote Mac client computer such as ‘test’.
<ip_address> specifies the IP address of the remote Mac client computer such as '10.10.0.0".

Example: .\Remote_lInstallation\Softwares\pscp.exe \MCCLAGNT.TAR .\Remote_Installation\
Scripts\install.sh test@10.10.0.0:/tmp/.

Open .\Remote_lInstallation\Softwares\putty.exe.
8 Enterthe IP address of the remote Mac client computer and click Open.

9 Inthe PUTTY terminal Window, enter the user name and password of an administrator user
on the remote computer.

10 Upon getting connected to the remote computer, type the following command sudo sh
/tmp/install. sh.

11 A confirmation message appears - "If earlier version of Seqrite Endpoint Protection client is
found on the system, then it will be uninstalled automatically. Do you want to continue??
[Yes/No]:".

12 Enter Yes or No.
e Ifyou enter Yes, installation will proceed.

e Ifyou enter No, installation will be aborted with message "Option No has been
selected. Installation aborted."

13 Type the command exit to close SSH connection.

14 Repeat steps 6 through 11 to install on a different Mac client computer.
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While installing the Mac client for the first time on Mac OS 10.13, user should allow permission
for loading the drivers manually when prompted.
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capter2. About Seqrite Endpoint Protection
Dashboard

You can access Seqrite Endpoint Protection from the desktop in any of the following ways:
e Click the Segrite icon in the menu bar and then select Open Segrite Endpoint Protection .

e Click the Segrite Endpoint Protection icon in Dock, if you have added Seqrite Endpoint
Protection to the Dock tray.

e Inthe Doctray, click Finder and then select Applications under FAVORITES. Click Seqrite
Endpoint Protection in the Applications pane to open the application.

Segrite Endpoint Protection Dashboard

When you open Segrite Endpoint Protection, Dashboard appears. The Seqrite Endpoint
Protection Dashboard is the main area from where you can access all the features. Dashboard
is divided into various sections: Seqrite Endpoint Protection menu, system security notification
area, Seqrite Endpoint Protection features, news and scan your machine option.

System security notification area indicates whether your system is secured and whether you
need to take any action with the help of message and protection icon, while news area displays
news about new events such as security alerts, some special release of Seqrite and so on.

System security notification area provides indication of the security status of Seqrite Endpoint
Protection with the help of colored icons. The colored icons and their specific meaning are
described as follows:

Icons Description

Green Indicates that Seqrite Endpoint Protection is configured with optimal
settings and your system is protected.

Indicates that a feature of Seqrite Endpoint Protection needs your
attention, if not immediately, but at the earliest.

Red Indicates that Seqrite Endpoint Protection is not configured with
optimal settings and your immediate attention is needed. The action
corresponding to the message needs to be executed immediately to
keep your system protected.

System security notification area is your instant interface to vital protection settings that can
affect files, folders, emails, and so on. It also allows users to configure protection against viruses
that try to gain entry through Internet, external drives and emails. Seqrite Protection Center is
split into two sections.

! Each colored icon has an action associated with it which needs to be executed by the user.
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Seqgrite Endpoint Protection Features

Seqrite Endpoint Protection ensures complete protection against any possible threats or
malware that may infect your system through various means. Seqrite Endpoint Protection
shields your system in the following ways:

Features Description

Mac Security Helps you configure scan preferences, virus protection, schedule
scan, exclude files and folders from scanning, and set rule for
quarantine and files backup.

Web Security Helps you protect your system against malicious threats when you
are browsing the Internet, or when you transfer data across in the
network.

Email Security Helps you protect your system against malicious threats and spams
that try to sneak into your system through emails.

The following are frequently used features:

Features Description
Scan Launches the scanner that scans the machine based on scanning
preferences.

Segrite Endpoint Protection Menus

With the Seqrite Endpoint Protection menus, you can configure the general settings for taking
updates automatically, password protect your Seqrite Endpoint Protection so that no
unauthorized person can access the Seqrite Endpoint Protection application, provide settings
for proxy support and removing reports from the list automatically.

The Seqrite Endpoint Protection menu includes the following:

Menu Description

Settings Helps you customize and configure the settings of Seqrite Anti-Virus
such as Automatic Update, Internet Settings, Password Protection,
Self Protection, Device Control, and Reports Settings.

Reports Helps you view the activity reports of Scanner, Virus Protection,
Email Protection, Quick Update, Anti-Phishing, Browsing Protection,
Web Security.
Quick Access Options

Quick access options are the options that you use to access Seqrite Endpoint Protection , turn
on or off Virus Protection, update the product, and scan the machine when required.

The quick access options include the following:
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Options Description

Open Seqgrite Launches Seqrite Endpoint Protection.
Endpoint

Protection

Enable / Disable Helpsyou turnon orturn off Virus Protection.
Virus Protection

Update Now Helps you update Segrite Endpoint Protection .

Scan My Mac Helps you scan your machine for viruses.

Help Topics

The Help topics assist you in understanding Seqrite Endpoint Protection features, how to use
them, and seek technical support when required.

To access the desktop integrated Help topics, follow these steps:
1 Goto Segrite Endpoint Protection > Menu > Help > Seqrite Endpoint Protection Help.
The Help topics appear.

2 Search for the information that you want.

About Segrite Endpoint Protection

The About Segrite Endpoint Protection screen includes the Company information with which
Segrite Endpoint Protection is register.

To access the About Segrite Endpoint Protection screen, follow these steps:

e Goto Seqrite Endpoint Protection > Menu > Segrite Endpoint Protection > About Segrite
Endpoint Protection .

The About screen appears.
The About screen includes the following license information:

e Segrite Endpoint Protection License Information: Organization Name and Virus Database
Date.

e Update Now: This button helps you update your license whenever required.

Updating with definition files

If you already have the update definition file with you, you can update Seqrite Endpoint
Protection without connecting to the Internet. It is specifically useful for Network environments
with more than one machine. You are not required to download the update file from the
Internet on all the machines within the network using Seqrite.

1 Goto Seqrite Endpoint Protection > Menu > Seqrite Endpoint Protection > Check for
Updates....

2 Onthe Welcome to Endpoint Protection Update screen, click Continue.

The Select the mode you prefer for updating Endpoint Protection screen appears.
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3 Select Pick from specified location.

4 Type the path or click the File button to the file location, and then click Continue.
Note

Quick Update picks up the definition file from the designated path, verifies its applicability on
the installed version and updates your copy of Seqrite Endpoint Protection accordingly.
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chapters. - Seqrite Endpoint Protection
Features

The Seqrite Endpoint Protection features include the most important features that help you set
the scanning preference, protection rules for your machine, scanning schedule, set rules for
Quarantine and Backup for files, apply protections for online browsing, Web Security and block
malicious emails and spams.

These features provide optimum protection to your system. Moreover, these features have to
be kept enabled all the time. If you disable these features, for any reasons, then the
corresponding icons for them will turn red.

Mac Security

The Mac Security option on Dashboard helps you customize the settings that concern the
protection of files and folders in your system. With Mac Security, you can set scanning
preferences, apply rules for virus protection, schedule scanning, exclude files and folders from
being scanned, and set rules for quarantine and backup files.

Mac Security includes the following:

Scan Settings

With Scan Settings, you can customize the way a scan is to be performed and the action that
needs to be taken when a virus is detected. However, the default settings are optimal and can
provide the required protection to your machine.

To configure Scan Settings, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.
The Mac Security setting details screen appears.

2 Click Scan Settings.

3 Setthe appropriate option for scan type, action to be taken if virus is found in the files, and
whether you want to take the backup of the previous setting.

4  Click Save to save your settings.

Select scan type

e Automatic (Recommended): Automatic scanning type is the default scanning mode, which is
recommended as it ensures optimal protection that your machine requires. This setting is
an ideal option for novice users as well.

e Advanced: Select Advanced mode if you want to customize the scanning behavior. This is
ideal for experienced users only. When you select the Advanced option, the Configure
button is enabled and you can configure the Advanced setting for scanning.
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Action to be taken when virus is found

Action that you select here will be taken automatically if virus is found, so select an action
carefully. The actions and their descriptions are as follows:

Actions Description

Repair During scanning if a virus is found, it repairs the file or automatically
quarantines it, if it cannot be repaired. When the scan is over, a
summary window appears providing the details about all the actions
taken and other scan details. If the infectious file is a Backdoor,
Worm, Trojan, or Malware, then Seqrite Endpoint Protection
automatically deletes the file.

Delete Deletes a virus-infected file without notifying you. When the scan is
over, a summary window appears providing the details about all the
actions taken and other scan details. Once the files are deleted, they
cannot be recovered.

Skip If this option is selected the files are scanned but no action is taken
on the infected files and they are skipped. Select this option if you
want to take no action even if a virus is found. When the scan is over
a summary report appears providing all the scan details.

Backup  before The scannerkeeps a backup of the infected files before disinfecting
taking action them. The files that are stored in the backup can be restored from
the Quarantine menu.

Configuring Advanced Scan Type

To configure Advanced Scan type, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click Mac Security.
The Mac Security setting details screen appears.

2 Click Scan Settings.

3 InScantype, select Advanced.

The Configure button is enabled.

4 Click Configure.

The Advanced Scan setting details screen appears.

5 Check Items to be scanned for Windows-based malwares.

By default this option is selected.

6 Select one of the following items for scanning:

e Scan executable files: Select this option if you want to scan only the executable files.

e Scan allfiles: Select this option if you want to scan all types of files. However, it takes time
to execute this option and the scanning process slows down considerably.

7 Turn Scan archived files ON, and then configure the scanning preference for the archive files
such as zip files and so on.
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8 Toclose the Archive Files screen, click OK. To close the Advanced Scan setting, click OK
and then click Save to save your settings.

Scan archive files

If you select Scan archive files, then the scanner will also scan archive files such zip files, archive
files, and so on. If you select Scan archive files, the Configure button is enabled and helps you
configure the way scanner should treat malicious archive files. You can scan files of various
archive file types till five levels down so to ensure no files are left from being scanned.

Following are the actions that you can select to be taken when a virus is found in any of the
archive files:

Actions Description

Quarantine Select this option if you want to quarantine an archive file that
contains a virus.

Delete Select this option if you want to delete an archive file that contains
virus-infected files. However, you are not notified if a file is deleted,
though its report is generated that you may see in the Reports list.

Skip Select this option if you want to take no action even if a virus is found
in any of the archive files. However, this option is selected by default.

Archive Scan level

Set the scan level till which you want to scan the archive files. You can set till five levels down
inside the archive files. By default, the scanning is set to level 2. However you can increase the
archive scan level which may though affect the scanning speed.

Select archive type to scan

You can select the archive file types that you want to scan from the archive files list. Some of
the common archive file types are selected by default. However, you can change your setting as
you prefer.

Types Description

Select All Select this option to select all the archive file types available in the
list.
Deselect All Select this option to clear all the archive types available in the list.
I ¢ Whenthescaniscomplete, asummary report appears providing the details
-

about all the actions taken and other scan details, irrespective of the option
that you had configured.

e Notification for the features such as Scan, Update, and Remote Uninstall from
EPP web console will not be sent to the users if they are not logged in to Mac.

e  Forschedule scan, if the system is shut down at the time of scheduled scan, the
scan will not run when the system starts.

e Forscheduler policy, if repeat scan is enabled, first scan will run at the
scheduled start time + repeat hours.

Seqrite Endpoint Protection Features 33



Virus Protection

With Virus Protection, you can continuously monitor your machine from viruses, malwares, and
other malicious threats. Such threats try to sneak into your machine from various sources such
as email attachments, Internet downloads, file transfer, file execution and so on.

It is recommended that you always keep Virus Protection enabled to keep your machine clean
and protected from any potential threats. However, Virus Protection is enabled by default that
you can disable if required.

To configure Virus Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.

The Mac Security setting details screen appears.

2 To protect your machine from malicious threats, turn Virus Protection ON.
3 To configure Virus Protection further, click Virus Protection.

4 Onthe Virus Protection screen, do the following:

e [tems to scan — Select this check box if you want to scan Windows-based malwares.
However, this check box is selected by default.

e Scan network volume — Select this option if you want to scan network volumes that are
mounted on your machine. However, this option is turned on by default.

o Display notifications — Select YES if Display notifications is selected, it displays an alert
message whenever a malware is detected. This feature is selected by default.

= Ifvirus found — Select an action to be taken when virus is found in a file such as Repair,
Delete, and Deny Access.

= Backup before taking action — Select this option if you want to take a backup of a file before
taking an action on afile. Files that are stored in backup can be restored from the
Quarantine menu.

5 Tosave your setting, click Save.

Action to be taken when virus is detected

Actions Description

Repair During scanning if a virus is found, it repairs the file or automatically
quarantines it, if it cannot be repaired.

Delete Deletes a virus-infected file without notifying you.

Deny Access Restricts access to a virus infected file from use.

Turning Off Virus Protection

Turn Virus Protection OFF. However when you try to turn off Virus Protection, an alert message
is displayed. Turning Virus Protection OFF is suggested only when you really require this.
Moreover, you can set it off for a certain period of time so that it turns ON automatically
thereafter.
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Following are the options for turning Virus Protection OFF for a certain period:
e Turnon after 15 minutes

e Turn on after 30 minutes

e Turnon after1 hour

e Turn on after next reboot

e Permanently disable

Select an option and click OK.

Once you turn off Virus Protection, its icon color changes from green to red in Menu Bar Tray,
which means that Virus Protection has been disabled temporarily or permanently based on
your selection. If you have selected any of the options for turning off temporarily or after next
boot then the icon color changes back from red to green after the certain time passes or at the
next boot. If you have selected to disable permanently, then the icon color remains red until
you enable Virus Protection manually.

Schedule Scans

With Schedule Scans, you can define time when to begin scanning of your machine
automatically. You can schedule multiple number of scan schedules so that you can initiate
scanning of your machine at your convenient time. Frequency can be set for daily and weekly
scans, that can additionally refine your request to schedule it to occur at fixed boot at fixed
time.

Configuring Schedule Scans
To configure Schedule Scans, follow these steps:
1 Onthe Segrite Endpoint Protection Dashboard, click Mac Security.

2 Onthe Mac Security setting screen, click Schedule Scans.

The Scheduled Scans details screen appears. Here you see a list of all schedules for scanning, if you had
defined any before.

3 To create a new schedule for scanning, click Add.

The Add Scheduled Scan screen appears where you can create a new scan schedule name, its frequency,
and other details.

4 Inthe Scan name text box, type a scan schedule name.
5 Set Scan Frequency:

e Daily: Select the Daily option if you want to initiate scanning of your machine daily.
However this option is selected by default.

o Weekly: Select the Weekly option if you want to initiate scanning of your machine on a
certain day of the week. When you select the Weekly option, the Weekly list is enabled
where you can select a day of the week.
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6 SetScan Time:

e Start scan at first boot: Select the Start scan at First Boot option to schedule the scanner to
scan at first boot of the day. When you select Start at first boot, you do not have to specify
the time of the day to start the scan. Scanning takes place only during the first boot
irrespective at what time you start the system.

e Start scan at Fixed Time: Select the Start scan at fixed time option if you want to initiate the
scanning of your machine at a certain time. When you select Fixed Time, the Start Time list
is enabled where you can fix the time for scanning. However this option is selected by
default.

7 Set Scan priority.
e High: Select the High option if you want to have the scanning priority at high.

e Low: Select the Low option if you want to have the scanning priority at low. However this
option is selected by default.

8 Scan location:

o Click Configure to open the Scan location screen, where you can select files and folders for
scanning. You can set multiple locations. Select the Drives, folder or multiple folders to be
scanned and press OK. You can configure Exclude Subfolder while scanning specific folder.
This will ignore scanning inside the subfolders while scanning.

9 Scansettings:

e Click Configure to open the Scan Settings screen. Under Scan Settings, you can specify
specific items to be scanned, action required to be taken if a virus is found and use of
advance options while scanning. By default setting is set for adequate options for scanning.

* InScan type, select one of the options from Automatic and Advanced.
To know about how to configure scan setting, see Scan Settings, p - 31.

= Select YES if you want to have a backup of files before taking any action on them,
otherwise select NO if you want no backup of files. This option is selected by default.

10 To save your settings, click Save.

Editing Schedule Scans

You can modify any of the scheduled scans whenever required. To edit a scheduled scan, follow
the steps:

1 Onthe Segrite Endpoint Protection Dashboard, click Mac Security.

2 Onthe Mac Security setting screen, click Schedule Scans.

A list of all scan schedules appears.

3 Select ascan schedule and then click Edit.

4 Inthe Add Schedule Scan screen, change the scan schedule as required.

5 To save your settings click Save and then click Close.
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Removing Schedule Scans

If you do not require a scan schedule, you can remove it whenever you require. To remove a
scan schedule, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.
2 Onthe Mac Security setting screen, click Schedule Scans.

A list of all scan schedules appears.

3 Select ascan schedule, and then click Remove.

4  Click YES to confirm if you are sure to remove the scan schedule, and then click Close.

Exclude Files & Folders

With Exclude Files & Folders, you can decide which files and folders should not be included
during scanning for known viruses or issues. This helps you avoid unnecessary repetition of
scanning of the files which have already been scanned or you are sure should not be scanned.
You can exclude files from scanning from both of the scanning modules Mac Security Scanner
and Virus Protection.

I Endpoint Protection Scanner scans files and folders when you scan manually while
Virus Protection scans each file and folder when accessed automatically.

Configuring Exclude Files & Folders

To configure Exclude Files & Folders, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click Mac Security.
2 Onthe Mac Security setting screen, click Exclude Files & Folders.

The Exclude Files & Folders details screen appears. Here you see a list of files and folders to be excluded
from scanning, if you have added any.

3 Click Add.

4 Onthe New Exclude Item screen, click the File button or Folder button to add relevant file
or folder to the list.

When you add a folder you can check Exclude Subfolders so that the subfolders are also excluded from
scanning.

5 Select afile or folder, and then click Open to add the selected file or folder and then click
Save to save your settings.

6 To close the Exclude Files and Folders screen, click Close.

Editing Exclude Files & Folders
You can change your setting for Exclude Files & Folders if you require so in the following ways:
1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.

2 Onthe Mac Security setting screen, click Exclude Files & Folders.
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The Exclude Files & Folders details screen appears. Here you see a list of files and folders to be excluded
from scanning that you have added.

3 Under Location, select a file or folder, and then click Edit.

4 Onthe New Exclude Item screen, click the File button or Folder button to add another file
or folder to the list.

When you add a folder you can check Exclude Subfolders so that the subfolders are also excluded from
scanning.

5 Select afile or folder, and then click Open to add the selected file or folder and then click
Save to save your settings.

6 To close the Exclude Files and Folders screen, click Close.

Removing Exclude Files & Folders

You can remove any files or folders that you included in the Exclude Files & Folders list if you
require so in the following ways:

1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.
2 Onthe Mac Security setting screen, click Exclude Files & Folders.

The Exclude Files & Folders details screen appears. Here you see a list of files and folders to be excluded
from scanning that you have added.

3 Under Location, select a file or folder, and then click Remove. You can remove all files and
folders from the list by clicking Remove All.

The selected files or folders are removed from the exclusion list.

4 To close the Exclude Files and Folders screen, click Close.

Quarantine & Backup

Quarantine & Backup helps in safely isolating the infected or suspected files. When a file is
added to Quarantine, Seqrite Endpoint Protection encrypts the file and keeps it inside the
Quarantine folder. Being kept in an encrypted form, these files cannot be executed and hence
are safe. Quarantine also keeps a copy of infected file before repairing if the Backup before
repairing option is selected in the Scanner Settings.

With Quarantine & Backup, you can also set a rule for removing the files after a certain period
of time and having a backup of the files.

Configuring Quarantine & Backup

To configure Quarantine & Backup, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Mac Security.

2 Onthe Mac Security setting screen, click Quarantine & Backup.

3 In Delete files automatically after, drag the slider to select days after which the files should
be removed from the Quarantine folder automatically.
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I Setting this feature helps in removing the quarantine/backup files after the
configured period of time. The removal of files is set to 30 days by default.

4 Click View Files to see the quarantined files. You can take any of the following actions on
the quarantined files:

e Add File: You can add files from folders and drives to be quarantined manually.
e Restore Selected: You can restore the selected files manually if required so.

e Submit Selected: You can submit the suspicious files to Seqrite research lab for further
analysis from the Quarantine list. Select the file which you want to submit and then click
Submit.

e Delete Selected: You can delete the selected files from the quarantine list.
e Remove All: You can remove all the Quarantine files from the Quarantine list.
e Submit Quarantine file functionality.

In Quarantine, when you select a file and click the Submit button, a prompt appears
requesting permission to provide your email address. You also need to provide a reason for
submitting the files. Select one of the following reasons:

= Suspicious File — Select this reason if you feel that a particular file in your system has been
the cause of suspicious activity in the system.

* Fileis unrepairable — Select this reason if Seqrite has been able to detect the malicious file
on your system during its scans, but has not been able to repair the infection of the file.

* False positive — Select this reason if a non-malicious data file that you have been using and
are aware of its function, has been detected by Seqrite as a malicious file.

Web Security

With Web Security, you can set the protection rules to save your machine from malicious files
that can sneak into your system during online activities such as banking, shopping, surfing and
so on.

Web Security includes the following:

Browsing Protection

With Browsing Protection, you can block malicious websites while browsing so that you do not
come in contact with malicious websites and you are secure. However, Browsing Protection is
enabled by default.

Configuring Browsing Protection

To configure Browsing Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Web Security.

2 Enable Browsing Protection.

You can disable Browsing Protection whenever you prefer.
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Phishing Protection

With Phishing Protection, you can prevent access to phishing and fraudulent websites. Phishing
is a fraudulent attempt, usually made through email, to steal your personal information. It
usually appears to have come from well-known organizations and sites such as banks,
companies and services with which you do not even have an account and, ask you to visit their
sites telling you to provide your personal information such as credit card number, social security
number, account number or password.

Phishing Protection automatically scans all accessed web pages for fraudulent activity
protecting you against any phishing attack as you surf the Internet. It also prevents identity
theft by blocking phishing websites, so you can do online shopping, banking and website
surfing safely.

Configuring Phishing Protection

To configure Phishing Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Web Security.

2 Enable Phishing Protection.

You can disable Phishing Protection whenever you prefer. However, you are advised always to keep
Phishing Protection enabled.

Email Security

With Email Security, you can customize the protection rules for receiving emails from various
sources. You can set rules for blocking emails which are suspicious of spam, or malware.

Email Security includes the following.

Email Protection

With Email Protection, you can enable protection rule for all incoming emails. You can block the
infected attachment in the emails that may be suspicious of malwares, spams, and viruses. You
can also customize the action that needs to be taken when a malware is detected in the emails.

However, Email Protection is enabled by default and the default settings provide the required
protection to the mailbox from malicious emails. We recommend that you always keep Email
Protection enabled to ensure email protection.

Configuring Email Protection

To configure Email Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Email Security.

2 Onthe Email Security setting screen, enable Email Protection.

Protection against malwares coming through emails is enabled.

3 To configure further, protection rules for emails, click Email Protection.

4 Turn Notify on email ON if you want an alert message when a virus is detected in an email or
attachment.
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! The alert message on virus includes the following information: Virus Name,
Sender Email Address, Email Subject, Attachment Name, and Action Taken.

5 Select one of the following actions to be taken if virus is found.
*  Repair: Select Repair to get your emails or attachment repaired when a virus is found

= Delete: Select Delete to delete the infected emails and attachments.

! If the attachment cannot be repaired then it is deleted.

6 Switch Backup before taking action to YES if you want to have a backup of the emails before
taking an action on them.

You can revert to default settings anytime you require so by clicking Set Defaults.

7 Tosave your settings, click Save.

Spam Protection

With Spam Protection*, you can block all unwanted emails such as spam, phishing and porn
emails, from reaching into your mailbox. Spam Protection is enabled by default and we
recommend you always keep the feature enabled.

Configuring Spam Protection

To configure Spam Protection, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click Email Security.

2 Onthe Email Security setting screen, turn Spam Protection ON.

To configure further protection rules for spam, click Spam Protection.

Turn Tag subject with text ON to include the tag “spam” to the suspicious emails.

vn » W

Select one of the following:

=  Turn White List ON if you want to allow emails from the email addresses enlisted in the
white list to skip from spam protection filter, and then click Configure to enter the email
addresses.

= Turn Black List ON if you want to filter out emails from the email addresses enlisted in the
black list and then click Configure to enter the email addresses.

6 Click OK.

7 Tosave your settings, click Save.

Setting spam protection rule for White List

White List is the list of email addresses from which all emails are allowed to skip from spam
protection filter irrespective of their content. No emails from the addresses listed here are
passed through the SPAM filter. It is suggested that you configure only such email addresses
which you rely fully.
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To add email addresses in the White List, follow these steps:
1 Turn White List ON.

The Configure button is enabled.

2 Click Configure.

3 Enterthe email addresses in the list and click Add.

Edit or Remove Email: To edit an email address, select the email address in the list and click Edit. To
remove an email address, select an email address and click Remove.

Import White List: You can import the White List by clicking Import. This is very helpful if you have a
long list of email addresses to enlist.

Export White List: You can export the White List by clicking Export. This exports all the email addresses
existing in the list. This is helpful if you want to import the same email addresses later. You can simply
import the email addresses list.

4 To save your settings, click OK.

Setting spam protection rule for Black List

Black List is the list of email addresses from which all emails are filtered irrespective of their
content. All the emails from the addresses listed here are tagged as "[SPAM] -". This feature
should be specifically evoked in case some server has an Open Relay which is being misused by
Mass Mailers and viruses.

To add email addresses in the Black List, follow these steps:
1 Turn Black List ON.

The Configure button is enabled.

2 Click Configure.

3 Enterthe email addresses in the list and click Add.

Important: While entering an email address, be careful that you do not enter the same email
address in the black list that you entered in the white list, else a message appears.

Edit or Remove Email: To edit an email address, select the email address in the list and click
Edit. To remove an email address, select an email address and click Remove.

Import Black List: You can import the Black List by clicking Import. This is very helpful if you
have a long list of email addresses to enlist.

Export Black List: You can export the Black List by clicking Export. This exports all the email
addresses existing in the list. This is helpful if you want to import the same email addresses
later. You can simply import the email addresses list.

4 To save your settings, click OK.
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Adding Domains to White List or Black List
To add specific domain in the White List or Black List, follow these steps:
1 Turn White List or Black List On and click Customize.

2 Type the domain and click Add. For editing an existing entry, click Edit.
Note

The domain should be in the format: *@mytest.com.

3 Tosave the changes, click OK.
Note

*Spam Protection is available only with the Advanced and Premium flavor of Seqrite Endpoint
Protection.
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chapters.  SCANNing Options

Scan My Mac option on Dashboard provides you with options of scanning your system in
various ways so that you can scan as you require. You can initiate scanning of your entire
system, drives, network drives, USD drives, folders or files, certain locations (Custom Scan).
Although the default settings for manual scan are usually adequate, you can adjust the options
for manual scan.

Scan My Mac

Scan My Mac is a complete scanning of your system. With Scan My Mac, you can scan the
entire machine, files and folders excluding mapped network drives, folders, and files whenever
you think your system needs scanning. However, if you keep Virus Protection enabled, you
need not run a manual scan. Moreover, the default setting for manual scan is usually adequate,
you can adjust the options for manual scan if required.

To initiate Scan My Mac, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click the Scan My Mac list showing at the
bottom right.

2 Onthe scan option, click Scan My Mac to initiate complete scanning of your machine.

Upon completion of the scan, you can view the scan report under Reports > Scanner Reports.

Custom Scan

With Custom Scan, you can scan specific records, drives, folders, and files on your machine that
you require. This is helpful when you want to scan only certain items and not the entire system.

To initiate Custom Scan, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click the Scan My Mac list showing at the
bottom right .

2 Onthe scan option, click Custom Scan.
3 Click Add to locate the path of the desired folder or drives that you want to scan.

You can select multiple folders for scanning. If you want to remove a file from being scanned, select the
file and click Remove. To remove all the files from scan, click Remove All.

4 Toinitiate scanning, click Start Scan.

Upon completion of the scan, you can view the scan report under Reports > Scanner Reports.
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chapters. - Seqrite Endpoint Protection
Menus

The Seqrite Endpoint Protection menus, available on the top left corner on the Segrite
Endpoint Protection Dashboard, give you instant access to the settings and report topics
options irrespective of the feature being accessed.

With the Seqgrite Endpoint Protection menus, you can configure general settings to take the
updates automatically, password-protect your Seqrite Endpoint Protection settings so
unauthorized users cannot access your settings, set proxy support, and schedule removing
reports from the report list.

Reports

Seqrite Endpoint Protection creates and maintains a detailed report of all important activities
such as on virus scan, updates details, changes in settings of the features, and so on.

The reports on the following features of Seqrite Endpoint Protection can be viewed:

e Scanner e Browsing Protection
e  Virus Protection e  Phishing Protection
e Email Protection e  Web Security

e Automatic Update

Viewing Reports

To view reports and statistics of different features, follow these steps:
1 Onthe Seqrite Endpoint Protection Dashboard, click Reports.

A Reports list appears.

2 Toview the report of a feature, click the report name. For example, if you want to view the
report on Virus Protection, click Virus Protection Reports.

The report details list appears. The report statistics on each feature includes Date and Time when the
report was created and the reason for which the report was created.

Details Helps you view a detailed report of the selected record.
Delete Helps you delete the highlighted report in the list.
Delete All Helps you delete all the reports.

Close Helps you to exit from the window.
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Settings

With Settings, you can configure some of the common settings of Seqrite Endpoint Protection
such as you can decide whether you want to take the updates automatically, password-protect
your Seqrite Endpoint Protection settings so unauthorized users cannot access your settings,
set proxy support, and scheduling the removal of reports from the report list. However, the
default settings are optimal and ensure complete security to your system.

Settings includes the following:

Automatic Update

With Automatic Update, Seqrite Endpoint Protection can take the updates automatically to
keep your software updated with the latest virus signatures to protect your system from new
malwares. It is recommended that you always keep Automatic Update enabled, which is
enabled by default.

Configuring Automatic Update

To configure Automatic Update, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Settings.

2 Onthe Settings screen, turn Automatic Update ON and then click Automatic Update.

3 Onthe Automatic Update screen, turn Show notification YES.

By default this feature is enabled. If Show Notification is turned on, you receive a notification each time
new updates are received, and you get a notification pop-up on Dashboard.

4 Select one of the following:

e Download from Internet: This option helps you download the updates to your machine
directly from the Internet. You may select this option in case your machine is not connected
with Endpoint Protection Server through LAN. This option is selected by default.

e Download from Update Agent: Select this option if you want to pick the updates from the
Update Agent.

For the Mac client, to take updates from the Update Agent, hostname and IP of the Update
Agent should be added in the hosts file on Mac system.

To add the hostname in the hosts file, do the following:
v.  Open the Terminal on Mac OS.

vi.  Enter command cd /etc.
vii.  Enter command sudo vi hosts
vii.  Enterthe hostname and IP of the available Update Agents in the hosts file.

iX. Save the hosts file.

e Pick from specified path: Select this option if you want to pick the updates from a local
folder or a network folder. This is helpful when your machine is not connected to the
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Internet, nor is your machine available in LAN. After selecting this option, browse the path
to pick the updates from the shared location.

5 Switch Save update files to YES.

Select this option if you want to save a copy of the updates downloaded to your local folder or network
folder. The Browse button is enabled. The Save update files option is enabled when you select Download
from Internet.

6 Click Browse to specify a folder or network folder to save a copy of the updates downloaded
from the Internet.

7 Tosave your settings, click Save.

Self Protection

With Self Protection, you can restrict unauthorized users from altering or tampering the files,
folders, configurations, and Plist entries of Seqrite Endpoint Protection configured against
malware. It is recommended that you always keep Self Protection turned on.

Configuring Self Protection

To configure Self Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Settings.

2 Onthe Settings screen, turn Self Protection ON.

However, Self Protection is turned on by default.

Password Protection

With Password Protection, you can restrict all other users from accessing Seqrite Endpoint
Protection so that no unauthorized users can make any changes in the settings. You are
recommended to always keep Password Protection enabled.

Configuring Password Protection

To configure Password Protection, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Settings.
Password Protection is turned off by default that you can turn on if required.
2 Onthe Settings screen, turn Password Protection ON.

The password protection screen appears.

3 Enter password in the New Password text box and then confirm the password by entering it
in Retype New Password.

If you are setting the password for the first time, then Existing Password is disabled.
4 Toreset your password, click Password Protection.

5 Tosave your setting, click Save.
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Device Control

With this feature, the administrators can create policies with varying rights. For example,

administrators can block complete access to removable devices, give Read only and no write
access so that nothing can be written on the external devices. They can also customize access
to the devices configured by the administrators. Once the policy is applied to a group, the
access rights are also applied.

Following is a comparison of device types across different Mac systems:

Devices DeviceTypes macOS Catalina and macOS Big Sur and
below above
Storage Devices USB Storage Device Vv v
Internal CD/DVD v v
Internal Card Reader v '
Internal Floppy Drive X X
ZIP Drive X X
Wireless Wi-Fi v '
Bluetooth v U
Interface FireWire Bus v X
Serial Port X X
SATA Controller X X
Thunderbolt v \
PCMCIA Device X X
usB v v
Others Local Printers v v
Teensy Board X X
Network Share X X
Unknown Device X X
Card Readers (C'\:;Ir_;:IDF;eader Device X X
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Card Reader Device
X X
(scsl)
Mobile & Portable Windows Portable
X . v v
Devices Device
iPhone \ Vv
iPad v v
iPod v v
BlackBerry X X
Mobile Phones
(Symbian) X X
Scar'mer & Imaging X X
Devices
Camera Webcam v X
Temporary Device
v v
Access
Device Exceptions v v

The Device Control policies can be configured remotely through Seqrite Endpoint Protection
console.

Configuring Device Control on Mac Client

To configure Device Control, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Settings.

2 Onthe Settings screen, turn Device Control ON.

However, Device Control is turned off by default.

The following are the exceptional conditions

= Ifthe option 'Read only 'is selected in Device Control of Seqrite EPP and a USB device is
attached such a device may not be accessible from the left pane in Finder for some time.

= Ifa USB device is to be shown as mounted or unmounted using terminal commands, the
Device Control policy will not apply to that device.

= Attached CD/DVD will get both read and write permissions even though the Read only
setting is applied in Seqrite EPP Device Control.

= If any of the iDevices, Webcam, CD/DVD, Internal Card Reader, Mobile Phones, and HFS
Encrypted devices are already attached to the endpoint and the Device Control settings are
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changed, the attached devices need to be re-attached so that the access rights are applied
to the new devices.

= Exception functionality is not applicable for Bluetooth, Wi-Fi, Webcam, and External
CD/DVD.

* Multiple notifications may be generated for CD/DVD.

= Mobile phones except iDevices that are connected in MTP mode, will be detected under the
USB storage devices category.

o Mobile Phones connected in MTP mode will be detected under the Windows Portable
Devices category.

* Ifyou are installing Mac client with USB devices attached to the system, such devices get
unmounted for a few seconds after installation.

= Ifa USB device with NTFS file system is attached during Mac client installation, two copies
of one attached USB may be visible for a few seconds.

» USB storage device will not be formatted with Mac OS extended (Journaled, Encrypted) file
format.

= The 'Authorized Wi-Fi connections' feature is not supported on Mac operating system.

* If the Wi-Fi connection is inadvertently blocked by the Admin via policy, the Wi-Fi
connection on the respective Mac endpoint will be disconnected. To re-enable it from the
endpoint, please follow the steps below:

* Login to Endpoint Protection Cloud Console > Click ‘Endpoint Protection’ > click
‘status’ tab > select Mac endpoint from where Wi-Fi gets disabled > click ‘Client
Actions’ > select ‘Temporary Device Access’ from drop down list > click
‘Submit’ > set time duration as per requirement under ‘Allow temporary access
forand ‘Use OTP within’ > Click ‘Generate OTP’ > Note down the generated
OTP.

= Now go to the Mac endpoint system > click Seqrite Endpoint Protection system
tray icon > select ‘Allow Temporary Device Access’ from the drop-down list >
Enter the OTP which is generated at EPP Console. Now devices will get
accessible for defined time interval set in the EPP console.

* Again go to the EPP Cloud console > click ‘Policies > click edit on respective
policy of Mac endpoint > click *Advance Device Control’ tab >click ‘Wireless and
Wired' > Allow the ‘Wi-Fi" and Save policy.

* Enable Wi-Fi on Mac endpoint.

= Admin can ask user to click on ‘Sync Now’ from Seqrite Endpoint Protection
system tray icon drop down list from respective Mac endpoint or wait for
heartbeat and once that is success then Admin can ask user to click the
“Temporary device access” from Seqrite Endpoint Protection system tray icon
drop down list or it will expire automatically after set time in the EPP Cloud
console under Allow Temporary Device Access.

= Asset Management: For Apple_APFS file system, OS drive will not appear in the Disk
storage section of Hardware Details.
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Data Loss Prevention (DLP)

e If Mac Applications are installed and launched from any location other than
“Applications” folder when DLP is enabled and all file types are monitored for blocking
in those applications, the applications won't be launched.

e DLP block functionality will not work on macOS Catalina 10.15 and above if
attachment sent through any mail application through Safari browser.

e File downloading is getting blocked through browser if DLP is enabled.

Proxy Support

With Proxy Support, you can enable proxy support, set proxy type, configure IP address, and
port of the proxy for using Internet connection. If you are using a proxy server on your network,
or using Socks Version 4 & 5 network then you need to enter the IP address (or domain name)
and port of the proxy, SOCKS V4 & SOCKS V5 server in Internet settings.

However, if you configure Proxy Support, you have to enter your username and password
credentials. The following Seqrite modules require these changes:

e Registration Wizard
e Mac Security Update
e Messenger

e Web Security (Browser protection, Phishing protection and Spam Protection)

Configuring Proxy Support

To configure Proxy Support, follow these steps:

1 Onthe Seqrite Endpoint Protection Dashboard, click Settings.

2 Onthe Settings screen, click Proxy Support.

3 Onthe Proxy Support screen, turn Proxy support ON to enable proxy support.

The Select proxy type, Enter server, Enter port, and user credentials text boxes are enabled.

4 Select the proxy type from HTTP, SOCKS V4, SOCKS V5 based on your preference.
5 Inthe Enter Server text box, enter the IP address of the proxy server or domain name.
6 In Enter port text box, enter the port number of the proxy server.

By default port number is set as 8o for HTTP and 1080 for SOCKS V4, SOCKS Vs,

7 Enter user name and password credentials.

8 Tosave your settings, click Save.

Report Settings

With Report Settings, you can set rules for removing the reports generated on all activities
automatically. You can specify the number of days when the reports should be removed from
the list. You can also retain all the reports generated if you need them. However, the default
setting for deleting reports is 30 days.
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Configuring Report Settings

To configure Report Settings, follow these steps:

1 Onthe Segrite Endpoint Protection Dashboard, click Settings.
2 Onthe Settings screen, click Report Settings.

3 Onthe Report Settings screen, turn Automatically delete reports ON to remove reports after
the specified number of days. If you want to retain all the reports generated, turn
Automatically delete reports OFF.

4 Select the period from the Delete after list after which you want the reports to be deleted.

5 Tosave your setting, click Save.
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caprers.  Updating Software & Cleaning
Viruses

The updates for Seqrite Endpoint Protection are released regularly on the website of Seqrite
that contain detection and removal of newly discovered viruses. To prevent your machine from
new viruses, you should have the updated copy of Seqrite Endpoint Protection . By default,
Seqrite Endpoint Protection is set to update automatically from the Internet. This is done
without the intervention of the user. However, your machine must be connected to the Internet
to get the updates regularly. Automatic updates can also be applied from local or network path,
but that path should have the latest set of definitions.

Some important facts about the Seqrite Endpoint Protection updates are:

e All Seqgrite Endpoint Protection updates are complete updates including Definition File
Update and Engine Updates.

o All Seqrite Endpoint Protection updates also upgrade your version whenever required, thus
making the new features and technology available for your protection.

e Seqrite Endpoint Protection Update is a single step upgrade process.

Updating Seqgrite Endpoint Protection from Internet

The Update Now feature keeps your copy of Seqrite Endpoint Protection updated
automatically through the Internet. However, your machine must be connected to the Internet
to get the updates regularly. This feature works for all types of Internet connections (Dialup,
ISDN, Cable, etc.).

You can also update Seqrite Endpoint Protection manually whenever required so in any of the
followings ways:

e Click the Seqrite Endpoint Protection icon in the menu bar, and then select Update Now.

e Ifthe Seqrite Endpoint Protection Dashboard is open, click Update Now which appears if
the protection is out of date.

e Open Segrite Endpoint Protection, and then on the menu bar, go to Seqrite Endpoint
Protection > About Seqrite Endpoint Protection . On the About Seqrite Endpoint
Protection page, select Update Now.

Update of Seqrite Endpoint Protection is initiated.

Ensure that your machine is connected to the Internet, Endpoint Protection Update connects to the
Seqrite Endpoint Protection website and downloads the appropriate update files for your software
and applies it thereafter to your copy thus updating it to the latest available update file.

Updating Seqgrite Endpoint Protection with definition files

If you have the update definition file with you, you can update Seqrite Endpoint Protection
without connecting to the Internet. It is useful for Network environments with more than one
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machine. You are not required to download the update file on all the machines within the
network. You can download the latest definition files from the Seqrite website on one
computer and then update all other machines with definition files.

To update Seqrite Endpoint Protection through definition file, follow these steps:
1 Onthe Segrite Endpoint Protection Dashboard, click Settings.

2 Turn Automatic Update ON, and then click Automatic Update.

3 Turn Show notification ON to receive notification when updated is needed.

4 Check Pick from specified path, and then specify the location from where the updates are to
be picked up.

5 Tosave your settings, click Save.

Your copy of Seqrite Endpoint Protection is updated from the specified location.

Update Guidelines for Network Environment

Seqrite Endpoint Protection can be configured to provide hassle free updates across the
network. You are suggested the following guidelines for best results:

1 Setup one computer (may be a server) as the master update machine. Suppose server name
is SERVER.

2 Make SEQRITEUPD folder in any location. For example: SEQRITEUPD .
Assign the Read-Only sharing right to this folder.

On the Seqrite Endpoint Protection Dashboard, click Settings.

On the Settings screen, click Automatic Update.

Switch Save update files to Yes.

Click Browse and locate the SEQRITEUPD folder. Click Open.

To save your setting, click Save.

©O 0O N o un W

On all other computers within the network, launch Seqrite Endpoint Protection .
10 Go to the Settings details screen and select Automatic Update.

11 Select Pick update files from specified path.

12 Click Browse.

13 Locate the SERVER\SEQRITEUPD folder from Network Neighborhood. Alternatively, you
can type the path as \SERVER\SEQRITEUPD.

14 To save the settings, click Save.

Cleaning Viruses
Seqrite warns you of a virus infection when:
e Avirusis encountered during a manual scan.

e Avirusis encountered by Seqrite Endpoint Protection Virus Protection/Email Protection.
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Cleaning viruses encountered during scanning

Seqrite Endpoint Protection is adequately configured with all the required settings with default
installation to protect your machine. If a virus is detected during scanning, Seqrite Endpoint
Protection tries to repair the virus. However, if it fails to repair the files of the viruses, such files
are quarantined. In case you have customized the default scanner settings, then take an
appropriate action when a virus is found.

Scanning Options

During scanning you are provided with the following options for your ease of operation:

Status Tab Displays the status on scanning.
Action Tab Displays the action taken on the files.
Skip Folder Helps you avoid scanning the current folder. Scanning moves to

other location. This option is useful while scanning a folder which
you know contains non-suspicious items.

Skip File Helps you avoid scanning the current file. This option is useful while
scanning a large archive of files.

Pause Helps you pause scanning while scanning is under process. This is a
temporary break and you may restart scanning after some time.

Stop Helps you stop the scanning process. This is a permanent break and
you cannot restart scanning from the same instance.

Close Helps you exit from the scanning process.

Scanning Status  Displays the status of scanning process in percent.
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Chapter 7. TEChnica| SUppOI’t

Seqrite provides extensive technical support for its registered users. It is recommended that
you have all the necessary details with you during the call to receive efficient support from the
support executives of Seqrite.

The Support option includes FAQ (Frequently Asked Questions) where you can find answers to
the most frequently asked questions, send emails about your queries, or call us directly.

To see the support options, follow these steps:

1 Open Seqrite Endpoint Protection .

2 Onthe Segrite Endpoint Protection menu bar, go to Help > Support.
Support includes the following options.

Phone support: Helps you call our support team to get your issues resolved.
Contact number for phone support: 1800 212 7377

Submit a Query (Email Support): Helps you send us your query. We will revert with an
appropriate answer soon.

Chat With Us (Live chat support): Helps you chat with our support executives to get your issues
resolved instantly.

Locate Dealer: Helps you locate a dealer nearest to your location.

Other Sources of Support

To get other sources of support, visit: http://www.segrite.com/contact _support.

For support in specific country, visit: http://www.seqrite.com/int techsupp.

Head Office Contact Details

Quick Heal Technologies Limited

(Formerly Known as Quick Heal Technologies Pvt. Ltd.)
Reg. Office: Marvel Edge, Office No. 7010 C & D, 7th Floor,
Viman Nagar, Pune 411014.

Official Website: http://www.segrite.com

Email: support@segrite.com

Technical Support 56


http://www.seqrite.com/contact_support
http://www.seqrite.com/int_techsupp
http://www.seqrite.com/
mailto:support@seqrite.com

